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. Course Syllabus
@@\ 8" Grade General Music with Technology
M:r. Williamson

A. Course Description

General Music and Technology (Grade 8) General music is an elaboration on the
fundamental musical elements taught at the elementary and intermediate levels with an emphasis on
the continued development of perceptive listening skills. The purpose of this course is to broaden
the students’ musical background, enabling them to become more knowledgeable consumers, utilizing
traditional and modern technological resources. Throughout the school year, students enrolled in
the General Music and Technology course will use technology in application for music

cducation. Notating, composing, sequencing, editing music on a computer, performing on rthythmic
and melodic instruments, and playing keyboard at a beginner level are some of the skills that will be
included in the coursework. Ideally, studeats enrolled and successfully completing this course will
have a wider musical background and be more knowledgeable music consumers through the
experiences provided through this course.

B. Course Topics and Unit Essential Questions

Course and Computer Orientation What does it take to be successful in this class?
Explain the differences in using a Mac computer.

Notation and Composition How does basic music notation assist in composing music?
Keyboarding How do basic keyboard skills aid in piano performance?

Sequencing, Recording, and Songwriting How can GarageBand encourage a young
songwriter?

Musicals and Film Scoting How is a musical different than a movie with music?

C. Activities and Weighting:
Graded activities are assigned throughout the learning process, and will include a
combination of the following types of activities each marking period.

Classwork/Homework 10-50 Points per assignment

Participation and execution of in class, and only occasionally out of class, assignments.
May include MusicAce computer guided session and games, in-class musical
performances, homework assignments, etc.

uizzes/Playing Tests 50-100 Points per assignment
Participation and execution of formal assessments, taken through either traditional or
technological methods. May include computer-based quizzes, keyboatd playing tests,
etc.

Projects 50-100 Points per assignment
Participation and execution of individual, partner, or small group ctreative tasks. May
include notating music, composing music, recording music, etc.

Daily Journals 50 Points per marking period
Participation and execution of individual reflective and listening journals. Journals are
cumulative, and must be kept throughout the school year.




D. Student Absence and Late Work

It is your responsibility to ask for any assignments or papets you may have missed. If
you are absent on the day a graded activity is due, you will be expected to turn in that
assignment on the first time you return to class. Any incomplete assignments will
automatically become zeros. Late work may receive a deduction in grade depending
upon circumstances of its lateness, and must be turned in before the end of the matking
period.

E. Classroom Expectations (GMMS School-Wide Expectations)

1. Be There, Be Ready

Enter classroom on time

Have all necessary materials (Music Notebook and a Pencil)

Follow beginning of class procedures (Daily Music Journal)

S.L.AN.T. (Sit Up, Lean Forward, Ask Questions, Nod Yes or No, Talk with Teachers)

2. Follow Directions

Raise your hand to speak and wait to be called upon before speaking
Stay in your assigned seat or atea

Ask for help if directions are unclear

3. Be Respectful

Be kind and considerate to all people and property
Use appropriate language

Keep hands, feet, and objects to yourself

4. Be Responsible
Complete work to the best of your ability and on time

Keep the classroom clean and orderly
Adhere to the school dress code

F. Behavior Consequences (Process may change depending on infraction)
1) Warning

2) Warning — Student/Teacher Conference

3) Warning — Student/Teacher Confetence — Telephone Parents

4) After School Detention — Notification Letter to Patents — Telephone Parents

5) Office Referral

G. Suggestions for Success

For most students, music class will not be a “difficult” course. Activities like listening to music
of different styles, writing, discussing, and learning about music and its’ parts, creating music,
through playing keyboard, recording, and clicking in sound loops are not difficult, but you must
be able to pay attention to directions, take advice, ask for help when you need it, and manage
your project time wisely. It is not uncommon for students who think they are “B” or “C”
students to earn a higher grade in this hands-on, creative environment. Just do not be afraid to
try in this class (even if music is not your thing), and most importantly, have fun — this class may
prove to be one of your favorite classes this year.
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8™ Grade General Music with Technology: Computer Orientation

Name: Section:

Learning Contract: This learning contract covers your computer orientation,
including three projects you will create. You are responsible to finish each of the
following, either alone, or with your partner if marked as such. Check off each box once
you have completed an activity.

Activities:
1. Required: Learn about Mac OS X with a manual.

[] Read and skim through computer orientation in your notebook (pages - )
(focus on icons, images and terms you may not already know)

2. Choice: Learn about Mac OS X with a video. (Choose one below)

[] If you are not familiar with computers, watch the video, Anatomy of a Mac.

[] If you are familiar with PC/Windows, watch the video, PC to Mac: The Basics.

] If you are familiar with Macs, choose another video, and write its name here:

Name of Video

3. Required: Learn Mac OS X through the Computer Orientation GoogleDoc.

v when [ Orientation Task
complete

1. Create your music class folder, include screenshot

2. Select your iTunes song, include screenshot

3. Research your music teachers, include facts (4) and screenshots (2)

4. Research 4 teacher facts, and copy an teacher image using Safari (as per
instructions)

5. About Me — Include your selfie, band/artist details (3) and music bio

[] Print and attach the Computer Orientation Activity Sheet you created.
4. Required: Complete the Computer Orientation Quiz.

[] Take the Computer Orientation Quiz Online at MrWlive.com
Print and attach your quiz score.




Citizenship and Work Habits:
I agree to the following learning conditions:
[] 1 agree to follow our class ground rules.
[J Iagree to complete my work on time. [Due /]
(Computer Orientation Activities must be completed within six (6) class periods
of instruction. Late work must adhere the school district policy regarding legal

absences, which allows one additional day for each day legally absent)

[] I agree to do my personal best.

Student’s Signature: Date:

Teacher’s Signature: Date:

Learning Contract Evaluation:

Self-Evaluation (Complete when submitting your completed materials) 12
Strongly Disagree Strongly Agree
Over the contract period, I worked at my highest level. 1 2 3 4
I used my time effectively. 1 2 3 4
I was respectful to teacher and peers. 1 2 3 4
Teacher-Evaluation (for teacher-use only) 120
Student used time effectively. 1 2 3 4
Student showed evidence of planning. 1 2 3 4
Student was respectful to teacher and peers. 1 2 3 4
Student was organized and prepared daily. 1 2 3 4

Student directed questions to peers, before teacher. 1 2 3 4



g@ COMPUTER ORIENTATION GOOGLeDOC

Follow the step-by-step directions for each part of this assignment. At the end of each part, follow the directions to
replace those directions with evidence of learning, as requested. Reference the rubric at the end of this document
with regards to grading as it pertains to procedural knowledge, following directions, technology, research, citations,
creativity, and motivation throughout this project.

Name: Workstation #: Section:

PART 1: Create a Folder in the right place including:
YOUR FIRST NAME, YOUR LAST NAME AND SECTION #

1. Open the folder *Music Class” on the desktop

2. Open your class’ period (for example, period 2)

3. Select “file,” then New Folder (you can also use the “gear” icon)

4. Type your first and last name, and your section # as the folder name
e.x. - Mark Troutman T1P2

Once you have created your folder, take a ScreenShot (3£+shift+4) of the Finder Window showing the your folder
in the Desktop > Music Classes > Period location Your picture should replace this section of directions. Please
keep the header!

PART 2: Select a Song Within the Program: iTunes

Open iTunes

Click on "My Music” to show the local music listing (music note icon on left column)
Select “Songs” using the text dropdown menu on the top right.

Scroll to a song that you know or like, and play it

® N O ;

Once you have selected a song within iTunes, take a ScreenShot (3§+shift+4) of the iTunes display showing the
title, artist and album picture. Your picture should replace this section of directions. Please keep the header!

PART 3: Research the GMMS Music Teachers Using their Webpages

1. Start at the district website http://www.GovernorMifflinSD.org

2. Visit Mr. Williamson’s and Mrs. Griffin's teachers’ pages and links:

a. find two facts about each teacher and copy it into this GoogleDoc

b. Info about Mr. Williamson’s Drumline teaching experience can be copied from his "Mustang

Drumline” page.
c. Info about Mrs. Griffin’s interests can be copied from her “Mrs. Griffin Info” page.
Be sure to copy facts about teachers from research, do not create facts or opinions without reference.

3. Copy one image from both Music Teacher's webpage to your Word Document

a. Select any image from Mr. Williamson and Mrs. Griffin‘s webpages

b. Drag and drop the image from your browser to the Desktop

c. Drag the image from the Desktop into this GoogleDoc

d. Remember to delete any temporary files from the Desktop to keep the desktop clear

Once you have researched two facts about each teacher and have an image from each Music Teacher’s webpage,
these elements should replace this section of directions. Please keep the header!

m PART 4: Research Music Using the GMMS Library Online Resources



¢

Start at the district website http://www.GovernorMifflinSD.ora
Go to the Middle School page

Go to the Library page

Open the Student Resource Center (General Resource) [scroll down]

View all topics under “Literature and the Arts”

Open the “Music"” topic, and answer the questions below into this GoogleDoc

ouhwunE

What are the four Eras of Western Music, from 1600 - Present?
What are the seven elements of music?

Be sure to include the source citation (source URL) for your responses.

Once you have answered these questions using the GMMS Library Online Resources, the questions,
sentence-formatted responses, and citation URL should replace this section of directions. Please keep the header!

PART 5: About Me

1. Using the Insert > Image > Take A Snapshot tool, take a selfie with a classmate or prop.
2. Using Google Search, look up a favorite band or artist that you like and include three of the following:
a. One artist picture or album cover image that best represents what draws you to this artist
b. One stanza (paragraph) of lyrics by this artist that resonate or connect strongly with you
c. Two of the following:
i The birthplace and date of this artist
if. The location and date of a famous performance
. iii. The deathplace and date of this artist
d. Three song titles you would recommend to someone who have never heard of this artist
3. Two sentences or more that describe your experiences in music. It can include music experiences in
school or outside of the school setting, as well as learning, performing, or listening/watching experiences.
Try to include aspects that have helped to define you as a developing musician or consumer.

Once you have created, researched and responded to these elements, organize your responses creatively so that
they replace this section of directions. Please keep the header!

DO NOT TYPE OR EDIT BELOW THIS LINE:

Grade

™



N I
Rubric Categories 10 - Exemplary 8 - Proficient 6 - Developing 5 - Beginning
Screenshot clearly Screenshot shows a Screenshot shows a There is no evidence
shows a folder folder created in an folder created in an of folder creation.
Folder created in the right incorrect spot or incorrect spot with
spot with the right with an incorrect an incorrect name.
name. name.
Screenshot clearly Screenshot shows an Screenshot shows There is no evidence
shows an iTunes iTunes song title, only an iTunes song of iTunes song
iTunes song title, artist and artistor album title, artist or album selection..
album picture. (3/3) picture, but not all picture. (1/3)
elements. (2/3)
Four Facts - Two Three Facts - one or One or Two Facts - There is no evidence
facts about each more about each one or more about of teacher research
Teacher teacher - are teacher - are each teacher - are from website.
(Facts) included, based on included, based on included, based on
research from research from research from
website, website. website.
Two Images - One One Images - for one Image(s) is/are There is no evidence
Teacher for each teacher - teacher -isincluded | included, but not of teacher images.
(Images) are included from from website. from assigned
website. website.
Research reveals Research reveals Research reveals There is no evidence
questions, accurate questions, accurate questions, accurate of library research.
Research answers, in answers, in answers, or
(Questions) sentence-formatted. | sentence-formatted, | sentence-formatted.
(3/3) but not all elements. (1/3)
(2/3)
Research Citation URL clearly Citation URL shows Citation URL shows There is no evidence
(URL Citation) shows evidence of an attempt at limited research of cited research.
effective research. effective research. attempt.
Selfie includes a Selfie either includes Selfie does not There is no evidence
classmate/prop and a classmate/prop or include a of a selfie.
Selfie illustrates an illustrates an classmate/prop nor
appropriate level of appropriate level of illustrates an
creativity. (2/2) creativity. (1/2) appropriate level of
creativity. (0/2)
Band/Artist Band/Artist research | Band/Artistresearch | Band/Artist research | There is no evidence
Research includes 3 of the includes 2 of the includes 1 of the of Band/Artist
following: image, following: image, following: image, research.




Musical
Resume

Creativity and
Effort

lyrics, dates &
places, or song titles

(3/3)

Musical Resume
includes 2 or more
sentences detailing a
high level of
personal reflection
regarding music.

Project format
(organization,layout/
fonts/color/etc.) is
highly original,
demonstrating
curiosity, motivation
and enthusiasm for
learning and
self-expression.

lyrics, dates &
places, or song titles

(2/3)

Musical Resume
includes 2 or more
sentences detailing a
moderate level of
personal reflection
regarding music.

Project format
shows some
originality,
demonstrating some
curiosity, motivation
and enthusiasm for
learning and
self-expression.

lyrics, dates &
places, or song titles

(1/3).

Musical Resume
includes 2 or more
sentences detailing a
average level of
personal reflection
regarding music.

Project format is
rarely original, only
demonstrating a
limited curiosity,
motivation and
enthusiasm for
learning and
self-expression.

There is no evidence
of personal
reflection regarding
music.

Project is lacking
originality,
demonstrating a
lack of curiosity,
motivation and
enthusiasm for
learning and/or
self-expression.




Computer Orientation

Turning On The Computer

iMacs - Push the power button on the back left.

The Desktop —_—

When you turn on the computer, the screen displays the desktop. On the
desktop you see small pictures or icons. Icons represent different files. The
icon’s shape specifies the category of each file type. Here are some examples of
categories.

Documents

‘Band=In=A=Box WFinale 20048 GarageBand iMovie




Computer Orientation
Opening a Program

Programs are opened from the Dock. The Dock appears at the bottom of your
screen. You simply click on the program or application (app) you want to open.

The Dock Icons

25 26 27 28 29 30 31 32 33 34

Applications: *indicates programs we will use in class.
1) Finder* 13) Finale* 25) MusicAce 2*

2) Stickies 14) iTunes* 26) QuizPress

3) Calculator 15) WireTap 27) EasyGrade Pro

4) Contacts 16) Snapz Pro 28) iPhoto*

5) Remote Desktop 17) QuickTime* 29) iMovie ‘06*

6) Mail 18) Microsoft Word* 30) iMovie ‘08*

7) Safari* 19) Microsoft Excel* 31) iWeb

8) iCal 20) Microsoft Powerpoint* 32) Parallels (Windows)
9) GarageBand* 21) Pages 33) Disk Utility

10) Band In A Box 22) Numbers 34) AppleWorks

11) Amazing SlowDowner 23) Keynote

12) Sibelius 24) MusicAce 1*

Open Program Indicator

ltems 1, 4, 7, 18, 20, and 34 in the Dock pictured above are open. Notice the

indicator below each program in the dock showing it is in use. Finder (1) is the

only program that needs to stay open for the computer to run properly. e



Computer Orientation

Program didn’t open? - Then it is open already!
(Look for the indicator)

Click on the program again in the dock.
You can tell by looking at the dock that a program is already Open because it will
have a white indicator under its icon in the dock. Click the icon again to make
that program the active application.

Program Menus
When a program is open and active its menu appears on the top of the screen.

@, Explorer File Edit View Go Favorites Tools Window

Program Not Acting Properly...

Try the following steps one-by-one if your program is not working properly...
(Unfortunately, you may loose any progress since your last save)

1) Quit the Program and Re-Open It
a. Command + Q will Quit the active program.
o o

2) Force Quit the Program and Re-Open It

a. Command + Optlon + Escape will bring up the force quit menu
|| = {' .
d, x_J. ;;l\l _;:s:

3) Restart the Computer

a. Click on the apple menu (top left corner) and choose Restart..
ﬂ AppleWorks File Edit Forr

About This Mac

Software Update...

Mac OS X Software...

System Preferences...
Dock
Location

v vv

Recent Items

Force Quit AppleWorks X {03D

Sleep
. Restart;..

| Shut Down...

4) Reboot the Computer
a. Press and Hold the computer power button for four seconds, then
release.



Computer Orientation

How to start a new project or document
After opening the program, choose FILE > NEW from the menu bar.

Adjusting the Computer Volume
iMac — Press the Mute, Volume Down or Volume Up buttons on the computer
keyboard. Gy :

Inserting a Flash Drive
iMac - Gently insert the Flash Drive into the USB slot in the back of the
computer’s keyboard.

File Organization on the iMacs

The Music Classes Folder is the Only Folder on the Desktop.
(Other items left on the desktop will be deleted, so SAVE carefully.)

Music Classes
(Contains Folders for each Period)

il e
Pl P2 P3 P4
(Contains Student Folders)

Ve, e (s
Bart Simpson Milthouse VanHoughton Nelison Munce Ralph Wiggum

My Section Is



Computer Orientation

Saving a file to Your Classroom Folder

Most of the time you will be working on a project that you have already started so
you will simply select FILE > SAVE. This only works after you have saved
your project once already!

The following window appears when you select File > Save for the first time.

When you first save your file, you will see an option screen like this...

Click the blue down
Save As:  Input Demos.band '\ E]‘_ arrow to expand your
Where: ' {3 Documents [ saving location Op[iODS.

" Save as Archive

i Saves movie and all Apple Loops into the project so you can move it 1o
' another Mac and continue working.

_ Compact Project Small - 128kbps AAC &) Choose a name you will
Reduces the size of the project on disk, making it easier to share. Also remember for your file.
reduces audio quality.

Your filename should
include your name and
(Cancel) Goaed i
section.
i.e. RalphWiggumGBandProj.band

With the blue
Save As: Input Demos.band ' [a] <«——— arrow pointing up,
you can locate the
< » ) (E}m) ([ Classwork 4] Qsearch " MusicClasses

folder on the

& MW Mac... | " ChorusRosterl.xls ~ [FA RAL g | degktop and
@ Network [ ClassFiles DL rRA2 - oate thronsh
=4 Macintos... = g ] RA3 ~ navigate throug

e — the section folders
—

“ [

l
7 i e " A 7 RAS ' to your folder.
2 Twilliamson|_ “-;‘ Ensemble Numbers L ' y
A Applications|| |  GM6-8Presentation.ppt i
4 _Documents |¥ _J
Y Save a5 Archive When the filename
Saves movie and all Apple Loops into the project so you can move it 1o and location is
another Mac and continue working. correct, click Save.
— Compact Project = Small - 128kbps AAC 3

Reduces the size of the project on disk, making it easier to share. Also
reduces audio quality.

T Hide Extension  {_ New Folder ( Cancel ) (- Save




Computer Orientation

Remember: Once your project was saved once just use “File > Save”
If you don’t save something correctly it will be lost when the computer is
shut off and you will have to start all over!! Remember to save your work

SAVE, SAVE, SAVE, YOUR WORK

Opening a Saved File

To open a saved file, navigate to the file via

Music Classes Folder \ Section Folder \ Student Folder \ Saved File
Your file will only be there if you have saved it correctly!!

Closing an open window

To close an open window, click on the red button in the Finder window.

ﬁ"j scottschwa.rtz :

A

[F schwanz
I Lm Applications

-H[ Dave.txt
{8 Desktop

[ Documents
| [ Experiments
| | [# Library

211 [Z Magazines
| s RMnnsiog

15 items, 2.46 GB availaﬂl‘:‘_l_e_‘ I

i m Desktop
i ,ér Applications

Closing an open application.
To quit an open application, select Quit from that program’s menu bar, or use the
shortcut Apple + Q to quit the active program.

¢ % P

AnpleWorks  File Edit  Fom
About This Mac i
software Update.., i

Mac 05 X Software... 1

Turning Off The Computer
You should only turn off the computer if you are asked
to do so. To turn off the computer, use

Dock

i
1 System Preferences... !
Location t

vy vvwy

Recent ftems
: 1
Force Quit AppleWorks T{3Y |

' sleep
1 Restart...

Apple Menu : Shut Down...

i
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Rhythm Level 1 - Information Page

First a look at some simple math:

Whole Half Quarter Eighth

O C

Challenge: Try some other numbers using the same pattern.
2
80
3742
Rhythm Chart - Level 1
Note Rest

Symbol Value Svymbol Name

4 - Whole Note - Whole Rest
2 . Half Note - Half Rest

1 d Quarter Note - Quarter Rest

o
J
)

JJ 1 (None) Two Eighth Notes



Rhythm Mnemonics:

mnemonics -

Name Yalue Symbol Mnemonic
Whole Note 4 o

Whole Rest 4 -

Half Note 2 J

Half Rest 2 -

Quarter Note 1 J

Quarter Rest 1 3

2 Eighth Notes 1 D

Directions: Cover the top portion of this page and fill in the blanks.

How many beats? Example: J —_— 1 Beats

Jl=_ pes J

__ Beats J — _____ Beats

- = Beats © — Beats i — Beats

What is its written name? Example: J — _ Half Note

Ji= - =
! = J =




Rhythm Level 1 - Math Clwk

Page

Directions: First enter the values of the notes or rests then solve the problem

using the math line.

Example: J + S| T J X J

Values: /
Math:

——

Do+ J —m —21 + = + J =

Values:

Math:

2dd+J — 1+ - +J) =) =

Values:

Math:

o Xm —d =J)X 1 X = =

Values:

Math:

4);+JXoT--XJ

Values:

Math:

-/
/
/
-/

5)l+oxﬂ—J—I-J+-.-=_

Values:

Math:

10



Rhythm Level 1 - Math Hmwk

Name Section

Grade Percent Weight Score

Directions: Solve the following problems. Do not leave any blanks

1)J+'-X3—OXJ+_D

Values:

Math:

2)J—.| +o — o+ J =)

Math:

Hdd X o ':-_-.—J"I‘JXi:*

Values:

Math:

4)0':'.D+--—.-.'.-1XJ

Values:

Math:

Values:

Math:

Page
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Students will choose and research an artist or band of their selection, creating a

written project (MS Word) or oral presentation (MS Powerpoint) to share their

findings.

Project/Presentation content must include cited research including the Name(s),

Date of Birth, Date of Death (if applicable), Hometown, Genre(s) or Style(s) of Music,

Top Song(s), Interesting Facts (3+), and Pictures of their artist or band.

Names: Section:

CRITERIA NOTES (include source for citations) POINTS
Name(s) /10
Date Of Birth /5
Date of Death /5
(or current age)

Hometown /10
Genre/Style(s) /10
Top Song(s) /10
Interesting Facts /30
Pictures /20

14



Rhythm Level 1 - Counting (1) Page

Beat -

Tempo -

Music is organized into groups of beats.
The most common patterns of beats are groups of 2,3, and 4 beats.

The grouping repeats itself with the strongest pulse felt or heard at the beginning of
the pattern.

Groups of 2
beat beat beat beat beat beat beat beat
Groups of 3
beat beat beat beat beat beat beat beat beat
Groups of 4
beat beat beat beat beat beat beat beat beat beat beat beat

Listening Exercise:

In written music the beginning and ending of a group is shown by a vertical line
called a bar line.

J\

beat beat beat beat I beat beat beat beall

13



Rhythm Level 1 - Counting (2)

Measure -

A Measure’s Three Parts I 1 2 34 I

1) Begins with a bar line / T

2) Has a set amount of beats inside it

3) Ends with a bar line

Composer -

Composition -

Using Notes and Rests in Measures - One Simple Rule!

The total amount of the notes and rests in a measure can not be more than the
set amount of beats per measure.

How many total beats? A) J.j 19' = beats B) . J = beats

If a measure has only 3 beats, which example would notwork?

How many total beats? A)J o W = beats B) J J = beats

If a measure has only 4 beats, which example would notwork?

If a composer decided to use 4 beats in each measure, circle the following measures
they could use in their composition.

-1 17,0 10
=1 1):J 1l




Rhythm Level 1 - Counting (3) Page

Write notes/rests inside the boxes according to the number of beats indicated.

3 beats per measure 4 beats per measure

4 beats per measure 2 beats per measure

Numbers or counts are assigned to each pulse in a grouping.

Groups of 2 Groups of 3 Groups of 4
beat beat beat beat beat beat beat beat beat
1 2 1 2 3 1 2 3 4

** Note - the STRONGEST PULSE is always beat ONE **

How to write counts when using different notes/rests

First, a reminder of the Note and Rest values (Rhythm Chart - Level 1)

Note Yalue Rest Name
o 4 - Whole Note - Whole Rest
J 2 - Half Note - Half Rest
J 1 { Quarter Note - Quarter Rest
D 1 (None) Two Eighth Notes

Second, a simple rule

- for Notes use numbers - Example: J or ©
12 1234

- for Rests use numbers in parenthesis - Example: .m. or wr
(12)  (1234)

Third, write the numbers directly under the symbols, do not be sloppy!

1h



Rhythm Level 1 - Counting (4)

How to write counts when using different notes/rests (continued)

Finally, counts or numbers are used to show what beats a Note or Rest occupies

sampe | o 1) 10200 2] = |

1234 12 (34) 1 23 4 (1234)

** Remember to write the numbers directly under the symbol. **

Exercise: You try it!

Ll AR JJ o

Exercise: Let’s try it backwards...write the symbols above the counts given

| | 1 ] |

(1234) 1T 2 (34 1234 12 34 1z2) 3 4

Exercise: Write the counts under the symbols

l2odlnn i)l

Exercise: Circle the symbol which falls on the count indicated below thaneasure

Example: IﬂJJIJlJﬂI

Beat #37 Beat #47

wldJil) | o JJ )]

Beat #27 Beat #17?

c>|ﬂﬂ...| D)IJlJl‘I -~

Beat #47 Beat #3?




Rhythm Level 1 - Counting (5) Page
Rhythmic Subdivision
When Notes or Rests are used that occur on the beat, subdivision is not needed.
lJ2Jaldr Jl
1 2) 3 @ 1 2 3) 4

Subdivision is needed when a beat has more than one sound in it .

|JJ'J.IJ;J|JJ:J|

A good musician uses counting to help them divide the individual beat evenly.

These beats have more than one sound in them.

Beats can be divided in 2,3 4, or more parts (all done with counting).

Counting within a beat is done using signs (+) or syllables (E or AH).

Eighth Notes [ ﬂ ] are counted using a plus sign (+) pronounced “AND”.
The first Eighth Note is always anumber according to what beat it falls on.

The second Eighth Note is always a plus sign (+).

meplelmmlmml

I+ 2 3 4+ 2+ 3+ @

Exercise: Write the counts under the symbols

** Remember to write the numbers directly under the symbols **

eyl s Yl N

Exercise: Let’s try it backwards...write the symbols above the counts given

** Remember to write the symbol directly over the numbers **

1 2 3 44+ 1 23 4 (12) 3+ 4+ 1 2 34

15



Rhythm Level 1 - Counting Clwk Page

pl JJ 1 o 1 JsJ1 o |
>l J ol o 1 o0 1 = |
SNl IV B B I
ol vl b J o Vsl b o
s ledad I o J 1ol o) |
o WDJRlIR) nJalln) |
IR RRIN AR R

s |70 JJVnn0nJyl

o LRI U



Rhythm Counting Homework Page

Name Section

Grade Percent Weight Score

Directions: Write the counts under the symbols

LJJJJbJuJ o1yl
FUNY I NN

WEYE N FuEE BN P

Directions: Write the symbols over the counts given.

1 2 3 4 (12) 34 (1234) I 2) 3 + 4 + 1234

I + 2 + (394) 1 23 @ 1 @3 4 + 12 3 + 4

Directions: Circle the symbol on the count indicated below the measure.

| D0t n)le L)l

Beat #27 Beat #4? Beat #1? Beat #3?
Lo dlJssle Ryl
Beat #1? Beat #3? Beat #2? The “And” (+) of Beat #4?

16
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C.BIl.

Trgl.

C.BL

Trgl.

C.BL

Rhythm Notation

Triangle /LH—J——D—J D—

1

J

T. Williamson

:

Cowbell -II-—Z—J——D_J_E

2
¢

i

l

M

I s s R N

2

PR B o s Bl B s s e B

QG

8/25/13 ©

M
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Level 1 - Rhythm Score Worksheet Page

Directions: Use the blocks below to write an 8 measure Rhythm Score for two players.
Fill the boxes with Notes and Rests. Each box should total four beats.

Measure # 1 Measure # 2
Measure # 3 Measure # 4
Measure # 5 Measure # 6
Measure # 7 Measure # 8

18



Rhythm Notation for Triangle and Cowbell

You have been hired to compose a piece for Triangle and Cowbell.
Follow these directions to type your composition.

ﬂ O First, log-in to Noteflight
https://gmmsmusic.sites.noteflight.com/
Your Username is: First Name (space) Last Name ; Password is music

2 Then, create a new “Blank” document by clicking the “New Score” button.
0

nn'lklllg_h( % ﬁ -': AD 'u‘?\l m O\ a‘

Vew Stah Haomo ‘Scores MAanageShe Soups  Libaiks G Ty ’ = Cezrcn

Home Your Scores  Estum == By Most Rocert |

Lean On Me Wthers Bulngsey @4 Aot 16 20

Yout Puple Scores o Sieze the Moment [o% far b 2207
-
Scores Shared witn You a =
“  Celebrate Mus:c ©: f 6 2007
Your Favontes ] s
" Al Ask of You Wenser/an. Bryrer [o Ao b 2047
Your News -
With a Voice of Singing Martn Shaw Ape & 2017
Mezsages <
Don't Siep Believin 2 A
Your Ddeted Scores 4 . °
Cotecton New £ % The Dream Keeper Hughes [ an Diworth As 20

N Ewara Erama

3 On the dlalog pop up, select “Percussmn and cllck “OK"
O

Create A New Sc_ore j

2 == stan from a blank score sheet
. = Piane

&= Piano and Vocal

= Treble Clet

£ Bass Clef

- = Rhythm

Yy Start by importing XML or MIDI files




A new score appears with one line for percussion.
Click the “Instruments” button to add a second percussion part.

0

TN
noteflight > - @
[T Py Tancrse  Rocord
soe o v g 38 ‘;i.}:' a5 6 auata ) 4
= eme | e 1200 3wtk T S AR > mem|+ - 2 § M 40 R |
»=120

.
==

RN

1

|

|

|
=

On the side “Instruments” pane, click “Add Instrument”
0 In the dialog pop-up, select “Percussion (1-line)” under “Unpitched Percussion” and click “OK”

e mmiem wureges 0 e e ey - .-
.
Pl - Ad instrumant x|
o & Q o ) LN m [Q ' ' | Percusyan
L RN s e e s i Cimoas btwtvaten S !
X v 2 : LT T Cimta's (lae g Bans T o
& > 2 Drums (Starcars
seald v
ik =@t § o ] Lrums iDerviees

Instruments X r)

Piace Groctons anowe stalt

| | [

With two Percussion staves in your score, close the “Instruments” pane with the “X” button.

Add Instiument’

Gira Seors octave
Mevonoms :

11

Foamson (2 drey e part

Porurssen i3 soef Pice Qrectons Koowe 2N
Hecyewa Perauon

Py Sampie |




With staves for two instruments, we are ready to edit our layout text.
0 Double-Click layout text to edit it. Text should read as follows...

=120
Percussion |H 2 -
| --Cc;f__nposér: (EIRST ‘LAST SECTI_O' Tl
i Located at topright of page. ; :
Percussion |H g W { b 2

Percussion (Staff #i): Tr.ian]c_
Located to the left of the first staff.

Percussion (Staff #2): Cowbell
Located to the left of the first staff.

Copyright: © TEACHERNAME MUSIC
Located at bottom center of page.
(Opt+G — mac /' Use (¢) — ehromebook)

|:| Once you have typed your layout, you are ready to type your music.

.=120 A. Click the staff line to select an edit position
B. Type “B” to enter a note

| T

Triangle Hi 2 g % g - a. [ * will shorten the highlighted note
b.  “]” will lengthen the highlighted note
C. Type “N” to enter a rest
a. “[ * will shorten the highlighted rest
Cowbell HI 2 = b. 17 will lengthen the highlighted rest




Noteflight Notation Project

fMatch Your Draft? (10 points per draft)
Your Handwritten Rough Draft should Match Your Final Sibelius Project.
flotes On line? (1 point per note)
Highlight any high or low note and use the arrow keys to move it.
Spell Check? (5 points per item)
Double-click on any text to edit it. Title, Composer and Copyright Information must be correct!
format Your Page. (10 points)
No partner — 2 Measures per line. Two people — 4 Measures per line. Click a bar line and hit return!
Delete Extra leasures. (5 points per error)
Highlight the measure click the “~” button above that measure to delete it.
l.gne: that Count! (1 point per note)

' hll

ht a note and use Command + L to add lyrics! Space bar moves you to the next note.
* for second eighth notes and remember parenthesis for rests.




Rhythm Notation for Tambourine and Triangle
You have been hired to compose a piece for Tambourine and
Triangle. Follow these directions to type your composition.

/
g First, open Sibelius 7.5 by clicking the icon in the dock:

Sibelius 7.5

2 Then, create a new “Blank” document by double-clicking the “Blank Document”
0

ese . wikted 3
BE v~ Meies Mostow T P e Avwewee  Pab Reves Vs N7

E 4 Ca Sam o7 AS3or Memove L TR , Vi Acvanma == Bors Prea-

- = ) %‘W“m
.y B I= Cravge Doeia B8 Jom

= i

v . e
3 With a Blank Document open, add instruments with the “Add or Remove” button.
O

Faen g Héser Coer Fasecr Puguws

ro80

Pajaiell | Bars§ | NoSeeson  Conced i 0 ad ] & owmow O v @

L



0

In the “Add or Remove Instruments” window, sclect Tambourine” under the “Percussion and Drums”
instruments, and then click “Add to Score.” Add “Triangle” to your score also.
are both in the “Staves in score” column, then click “OK”

Once “Tambourine and Triangle”

Aag nstrument

fing.

Choosafrom: | Common lstruments

‘Add or Remave lr:llrun‘\nmlr

Add lo Scoro

Doleme ko Score

v
| » Drass

Puiched Porcuttion

avew
-

Down

Cava g

Above

Bulow

Stavos in scote:
‘ 1.mmul€n'~..,.

Sratt gt

cocs

After you add instruments, you will see them in your music. Once you have your instruments, click the

ene

0 *“Add Bars” button to add the correct number of measures at the end of your piece.

imog.ar
leg. {8 Aot I 5ama 03 The
Brevaiing e sgatire,

ok B af fl & 100w @ @ ®




With measures for Tambourine and Triangle, we are ready to add our layout text.
0 Use the Right Click to create text on your Score. You will need to create:

e e - = untitledd
“ Homo Mot Input Hetons Toxt Play Layout Appoarance Pans Raviow View : ald
4« Fom © Sio 60 » bJE @ =t ) Y
3 Neme sute :EE s o B e Fun oS3 Lo Marocrng  Plagina
| Format = Sos Lyrcs. Rohesrzyl iares fa
o s R R e T i
Bar >
Bartine
Condsymod %K ; LAl : St
& Comment \ec “Located'at top.center-of page. -
Graphic... Ba A ; i 3
T b . mlw 1 i } ) g % 5
ambourine - - - - f ¢ T
! Sl h el fr b
| KerSgmus. K R qmpqsm.-_rl]\S i
| Roheavsal Mar.. A 1 SECTION)
| Triangle - — Seerionin *e Located atitop right of page.
Title Page... Lyres >
Tuple... Other Stat Text > i
Other b Tie Copyright:Information:
Chciitha! BRI AVE. 1 i 2 i
Compossr Copyrieht € WILI
Dedication ML
Tempo \RT PR Lo i
o o ' Cnwmea > " Located ar bottom center of
fl;:y!-pul-n v [Cmie ! Biank Page Text > page.
Ocher T Teavie Willsamson be. 2 I
'M:r'w;::n = i = T ¥ T Spacial Taxt »
lambeurn:
Inasgie
{=3 ) I . |
X ool 162 10000 @ 3] @ |

Once you have typed your Title, Composer and Copyright Info, you are ready to type your music.

O Keypad Typing Notes in Sibelius is a two-step process.
=S

= ET Step 1: Choose your value. (Reference the keypad shown here.) S G
I3 {? B li’.“ (i.e.4 = Quarter Value, 5 = Half Value, etc.) L‘.."";‘.‘J*_J_‘_.J;_.J
ETR e e )]
———————— Step 2: Type a Note or Rest. S S e e
£ jid o | > (ie.B=Note,0=Res) ads de 1.1
Y YTy O 1

LA I ~ For example, 5+B = Half Note, 4+0 = Quarter Rest -'—maz—ﬁl 4 ‘
= 3 7 g ‘E \a—--,-.-..o i \.n':'-’/l

That’s It. Click in your first measure and start typing your music!
T R e e ™, e e L TR o R e R T S S TV,

2d



Sibelivs Notation Project

Match Your Draft? (10 points per draft)

Your Handwritten Rough Draft should Match Your Final Sibelius Project.

fiotes On line? (1 point per note)

Highlight any high or low note and use the arrow keys to move it.

Spell Check? (5 points per item)

Double-click on any text to edit it. Title, Composer and Copyright Information must be correct!

format Your Page. (10 points)

No partner — 2 Measures per line. Two people — 4 Measures per line. Click a bar line and hit return!

Delete Extra Measures. (5 points per error)

Highlight the measure and use Command + Delete to remove unwanted measures. (Check all pages!)

lyries that Count! (1 point per note)

;_.HAT._i_gh‘I.ight a note and use Command + L to add lyrics! Space bar moves you to the next note.

mber to hand-write counts for rests after printing, since rests can not have lyrics!




The Piano Keyboard

A standard piano heyboard has 88 heys 52 white heys and 36 blach beys Each hey plays s specific aote,
and the keyboord annanges these notes int a patiern

The Piano's Repeating 12-Note Pattern

A piano heyboard contains seven groups of 12 notes each Each group is made up of scven white heys and five

black heys. Vithin a group, eath bey has a unique note This paticin of notes it then repeated in cach of the

smwn

- - -

! .

seven groups.
1

Though the notes withsn cach group arc identical in letter name, they are higher o1 lowes in piteh depending
on the group’s location on the heyboard. The farther to the Ieft a group sits on the keyboard, the lowet in
pitch the notes it contains will be

The Piano’s White Keys

The white heys on s piano play whai arc calied aatsral notes. There are seven natural notes, one for cach
of the seven white heys in a group of 12. The seven natoral notes are named with the fisst seven Ictters of the
alpbabet A,B,C, D, E, F, and €. The seven white heys in a group of 12 do ot follow alphabetical grder,
though The fisst white hey in cach group of 32 is o €, followed by D, E, F, G, A, and B. The nest group begins
with the following (.

The Plano's Black Keys

The black keys play notes that come between the natural notes played on the white heys. These “between”

@oles are called cither sharps or flats Tyt s tepe

|
|

wtiok < e

C and Middie ¢

The C hey closest to the center of the entire pinno heyboard is hnown 2s middle €

f
|

middle C

33



Piano Finger Numbers

In piano playing, the termfinger numbers refers to which finger you use to play each
key. To play piano most comfortably and etliciently, you'll need to know correct finger

numbers, or the best finger to use to play each note in a picce of music.

The purpase of using correct fingers is to position your hands and fingers so you'll be able
to play the current note and reach the key for the neat note without having to rearrange

your fingers or relocate your hands, which can interrupt your playing.

The Piano Finger Number System
The piano finger number system numbers the fingers of cach hand from 1-5, starting
with the thumb. Finger numbers appear above and below the staff and tell the pianist

which finger to use to play each note.

left right

Numbers that appear above the grand staff indicate fingerings for the right hand.

Humbers that appear below the grand staff indicate fingerings for the left hand.

Complete finger number guidelines are usually provided only in music written for
beginners. That said, in most beginner pieces, and in nearly all advanced pieces, fingering

infarmation is often provided only for difficult passages.



Right Hand Keyboard Position
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Left Hand Keyboard Position
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Right Hand Keyboard Position
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Warm-Up
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Position: C
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Right Hand: *Merrily, We Roll Along"
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AU CLAIR DE LA LUNE

FREMCH FOLK SONG

et as e Y NCQ?D?IDJ

C
e

“Ode to Joy™ by Ludwig van Beethoven

Flace your raght hand i C postion (o andidle ©) an your keshoard  Bem
2-black key prop

b1 Jd Il
§dJ I Iy



C MAJOR FIVE FINGER POSITION

1 [2]3]4 i [ 5
RIGHT HAND
j2u:! ;,id
RIGHT HAND (R.H.) i
Warm-Up
Position: C
ﬂ ! i 1
~ ] ]
P SE—— 1= 11 :
ﬁ__;‘ — —— <
up sameo down
AU CLAIR DE LA LUNE
St =
FRERE JACQUES
%:‘ 3 1 P - i 3 3 ; 1 {
SESEEESS e e
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Ode To Joy
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page
Treble Clef and Staff

Music notes are named after the first seven letters of the alphabet, from A to G.
ABCDEFGJABCDEFGJABC ..

Clef signs help organize the staff so notes can be easily read. The two most common
clefs are:

r—-

e
Treble Clef

— =E

Bass Clef

The TREBLE CLEF is used for notes in the higher ranges. To correctly draw a treble
clef, use the J4132 process:

7
=

The curl of the TREBLE CLEF (Step 5) circles the line on which G is placed. Thus, a
TREBLE CLEF is called a G CLEF.

G

This G is above MIDDLE C on the keyboard (the C nearest the middle of the
keyboard).

Y |mrgo-xz



To find C on the keyboard, locate a set of two black keys on the keyboard. C is the
white key to the left of the 2 black keys.

y

In the treble staff,

the names of the — < - o—
notes on the lines ©

from bottom to t e

areE, G, B, D, F. | Every Good Boy  Does  Fine
The names of the é — K —

notes in the spaces

from bottom to top e F A c E

spell FACE.

Here are the notes of the TREBLE STAFF and where they are on the keyboard
E F G A B C D E F

% s S—_—
—— n—O— I %7
b ] -—

meggo-

A



page

Treble Clefand StuffExercises S S ——

1 The treble clef using

J4132. Draw 4 treble

clefs.

2 Write the letter names of the following notes. USE CAPITAL LETTERS.

4\3 | & ) c — e — Ty - L & 3
5 e
3 Place an asterisk (* ) on the keyboard where the note C would be located.

i
i

=3




™

4 Write the letter names of the following notes using CAPITAL LETTERS, than
place an asterisk ( *) on the keyboard where the note would be located.

= = ==

L2 X

Hi
= = =

_ )

LRI

5 Write the notes on the staff indicated by the letters. If the notes can be written

in two place, write both notes. Place an asterisk (*) on the keyboard where
the note would be located.

G A

V0 Y -




Name: Section : Page

M Treble Clef and Staff Homework =————m —

Write the letter names of the followine notes. USE CAPITAL LETTERS.

L & 3 L $ 1

cg;%. o

it
I
¢
@
Q
[
]
i
z
[

Q#ha
)
9

2 Place an asterisk (*) on the keyboard where the note C would be located.

m




3 Write the letter names of the following notes using CAPITAL LETTERS, than
place an asterisk (*) on the keyboard where the note would be located.

== = =

e e e

W mmy
= =

: =

¢!

SLLLLILE]

4 Write the notes on the staff indicated by the asterisk ( * ) on the keyboard. Write the
letter names of the notes using CAPITAL LETTERS in the space provided.




Left Hand Keyboard Position
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AU CLAIR DE LA LUNE

FRENCH FOLK SONG )
Position: C
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ODE TO JOY
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C MAJOR FIVE FINGER POSITION
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AU CLAIR DE LA LUNE
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ODE TO Joy
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Bass Clef and Staff

Music notes are still named after the first seven letters of the alphabet, from A to G.

ABCDEFGIABCDEFG ABC..

Clef signs help organize the staff so notes can be easily read. The two most common
clefs are:

Treble Clef Bass C _

The BASS CLEF is used for notes in the lower ranges. To correctly draw a bass
clef, use this three step process:

Step 1:

Step 3:

The 2 dots of the BASS CLEF (Step 3) surround the line on which F is placed.
Thus, a BASS CLEF is also called an F CLEF.

W

3



This F is below MIDDLE C on the keyboard (the C nearest the middle of the
keyboard).

megg-Z

C

REMEMBER, to find C on the keyboard, locate a set of two black keys on the
keyboard. Cis the white key to the left of the 2 black keys.

y

In the bass staff,

9

the names of the s

2

notes on the lines 7 P — =

from bottom to to g -
are G, B, D, F, A. P Good Boys Do Fine Always

The names of the

notes in the spaces %) = o —
from bottom to top XF

spell A, C,E, G. All Cows Eat Grass

Here are the notes of the BASS STAFF and where they are on the keyboard.
G A B C D E F G

==




BaSS Clefand StaﬁExerCiseS _—_-___p

1 The bass clef is
written in three
steps. Please write
four bass clefs.

2 Write the letter names of the following notes. USE CAPITAL LETTERS,

L
«r

=¥ 2 — < =
3 Place an asterisk ( * ) on the keyboard where the note C would be located.

LILIILILL
m o
n o

I
{

age

33



4 Write the letter names of the following notes using CAPITAL LETTERS, than
place an asterisk (*) on the keyboard where the note would be located.

™

dILILLLOS L LILLILRLLLILL

Hum [y SN

Write the notes on the staff indicated by the letters. On the notes G and A, the
arrow indicates whether it is the lower or higher note.. Place an asterisk ( * )
on the keyboard where the note would be located.

D E

ALILLILSRLILLILL O LLILLIL

G F e

mm o -




Name: Section :

Page

Bass Clef and Staff Homework

1 Wrrite the letter names of the following notes. USE CAPITAL LETTERS.

@
(
®

N
@

i — — — Ty — e — L & |
2 Place an asterisk ( * ) on the keyboard where the note C would be located.

1
LL

RH



3

4

Write the letter names of the following notes using CAPITAL LETTERS, than

place an asterisk (* ) on the keyboard where the note would be located.

LLILLLI LLILITL L1

dLL

1

Write the notes on the staff indicated by the asterisk (*) on the keyboard. Write the

nm  mmmn

letter names of the notes using CAPITAL LETTERS in the space provided.

HILLILL

1]

-

L1l

LI

J

T

»‘%S
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, IRCTIVITY 1 namerciaz:
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Dz'rmer r T’CDD ipell words by writing the note names
g

1o complete ine sentences helow.
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| Py FaY =
= = et
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. 4 = X
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Keyboard Performance and page
Notation Projects

Keyboard Performance Preject “When the Saints Go Marching In”
Each student must play “When the Saints Go Marching In” at a steady tempo, using

correct notes any rhythms.

Keyboard Notation Preject “When the Saints Go Marching In”

Each student (at Workstation Group) must notate “When the Saints Go Marching In,”
following the same procedure for the Rhythm Notation Project, with the following
directions as a supplement...

Additional Sibelius Notation Directions. ..
Title: The Title Should Be: When The Saints
SaveAs: Filename should include “Saints™ and all composers last names

Changing Pitch when entering notes:

How do you enter notes? Here’s the Key!

'O Keypad First, Open the Keypad Window

1. Window > Keypad

(Ifit is already checked, it is open.) e Ty T
Second, Note Values are set by pressing the matching key on the L, i 3 L’..] i !

computer’s number keypad (far right).

For example, “4” enters a quarter note. U
For example, “4” with “.” enters a dotted quarter note. s_‘__}}_JL_J !
) (Sharps/Flats/Naturals are also entered with the keypad!) 0 L_l _:_,.J
How do you change the pitch? It’s Alphabet Time!!
To Start Notating...

1. Select the first available rest where you want to begin.

2. Hit “N” for Notation

3. Press the Note’s duration on your number keypad

4. Press the Note’s letter name A/B/C/D/E/F/G on your text keyboard.
The note will appear! You did it!!

Apple + Up Arrow will raise the Octave
Apple + Down Arrow will lower the Octave

Adding Lyrics (Words):

1. Click on the first note that needs words below it.

2. Press Apple + L to enter “Lyric Text Mode”

3. Type your word. Hyphen (-) or Space Bar will move you to the next note.
Remember, Lyrics have only one syllable per note!
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GarageBand Project 1:
Getting Started With Loops

We have been exploring music through study of musical elements. Using
GarageBand, you are now the composer! Using GarageBand loops and a few music-
specific guidelines (with corresponding instructions indicated below), you will
create your own song, either alone or with a partner. In five class-periods you will
set-up your file, create your sound pallet of instruments, and develop an original
and creative 32-measure composition that includes a clear introduction, call and
response, key change, and fade-out, with aesthetic variety and design for the
listener. Student projects will be assessed using the accompanying rubric.

Musical Element Guidelines for GarageBand Project 1.

Time and Texture (Rhythm and Tone Color)
- Song must use a Tempo of 120 beats per minute (bpm). (1-1)
- Song must use a Time Signature of 4/4 (common time). (1-1)
- Song must include at least one rhythm instrument. (1-2)
- Song must include at least four total instruments. (1-3)

Form and Dynamics...
- Song must meet a minimum length of 32 measures. (1-4)
- Song must use an introduction before the melody enters. (1-7)
- Song must introduce the melody around measure #4. (1-5)
- Song must include a call and response. (1-6)
- Song must include at least one key change. (1-8)
- Song must include an ending fadeout. (1-9)

Other expectations:

- Students will demonstrate technology understandings such as
appropriate vocabulary, procedural knowledge, and excellent care in the
creation of their project.

- Student work will be original and creative, and designed with the listener
in mind.

- Students will demonstrate curiosity, motivation and enthusiasm in
developing their own approach to this assignment.

Song Description Sheet

In addition to the GarageBand song file, students will also complete a Song
Description Sheet specific to their composition, detailing musical and non-
musical elements, as well as possible improvements for their composition if
time restraints did not exist. The template and assessment rubric for the Song
Description Sheet is attached.
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GarageBand Project 1: Getting Started with Loops Rubric Name(s):
(7]
(] . .
9@ a Exemplary (4 points) Proficient (3 points) Developing (2 points) Beginning (1 point)
o |° Musicalloops are aligned correctly tofit | Musical loops are aligned correctlyto ¢ Most, but not all, musical loops are * There islittle evidence of the required
5 perfectly within the required time fit the required time signature and aligned correctly to fit the required time time signature or tempo, or the loops are
g signature and tempo of the song. tempo of the song. signature and tempo of the song. incorrectly aligned within the measures of
-
e | Composition has at least four or more * Composition has at least 3 total ¢ Composition has at least 2 total the song.
o total instruments, including rhythm instruments, including rhythm instruments, including rhythm instruments | ¢ Composition does not include any rhythm
g instruments (drums, bass, guitar or instruments (drums, bass, guitar or (drums, bass, guitar or piano). instruments (drums, bass, guitar or piano).
[ piano). piano).
* The structural parts of composition (call | * The structural parts of composition ¢ The structural parts of composition (call * Very little if any structural elements (call
g and response, key change, etc.) are very (call and response, key change, etc.) and response, key change, etc.) are and response, key change, etc.) are
E evident and clearly defined. are evident and defined. recognizable. It may be difficult to hear present.
s al s
S |+ Composition has a logical introduction, * Composition follows a somewhat some structural parts * Composition lacks any sense of
(=) middle and end. Build-up, climax, and logical progression of introduction, ¢ Composition is hard to follow and does introduction, middle and end. Build-up, ,
e fade-out are all in the correct order and middle and end. Build-up, climax, and not present a clear introduction, middle climax and fade-out are not existent.
g make sense. fade out are somewhat present. and end. Build-up, climax, and fade out
= are confusing or do not make sense. *  Student has less than 20 measures
2 |°* Student has 32 measures or more ¢ Student has 28-31 measures included included in their composition
included in their composition. in their composition. ¢ Student has 20-27 measures included in
their composition
* Demonstrates full understandingof the | »  Displays complete understanding of * Demonstrates incomplete understanding | * Demonstrates strong lack of the
important aspects of the technology and the important aspects of the of the important aspects of the understanding of the technical use of the
& its’ use with music. technology. technology. computer.
=
2 |°* Demonstrates full understanding and * Displays complete understandingand | * Demonstrates incomplete understanding | * Demonstrates strong lack of
.3 practice of the technology concepts, practice of the technology concepts, and practice of the concepts, vocabulary understanding and practice of the
H vocabulary and procedural knowledge vocabulary and procedural knowledge. and procedural knowledge. technology concepts, vocabulary and
k-
§ * Demonstrates full understanding and * Demonstrates full understandingand |* Demonstrates some understanding and procedural knowledge.
s practices excellent care for technology in practices good care for technology in care for technology in the classroom. * Demonstrates lack of understanding and
H the classroom. the classroom. Reminders for appropriate care were care for technology in the classroom.
F needed. Multiple reminders for appropriate care
were needed.
£ |* Projectis highly original, demonstrating | ¢ Projectis original, demonstrating * Projectis rarely original, demonstraﬁng * Project is lacking originality, and seems
,g variety and interesting sound some variety. Evidence of creation for little variety. Evidence of creation for the random. The project shows little attempt
8 combinations that is clearly constructed the listener can be detected. listener cannot be determined. to create something new.
8 with the listener in mind. * Student usually demonstrates * Student sometimes demonstrates * Student rarely demonstrates curiosity,
,é" * Student consistently demonstrates curiosity, motivation and enthusiasm curiosity, motivation and enthusiasm for motivation and enthusiasm for learning
'E curiosity, motivation and enthusiasm for for learning. learning. concepts.
§ learning.
(s}




ageBand Song Desc

cidassroom t

ription

Song Title: Hopsicle

Song File Name: 1-7B-RONDO

Computer Number: 1

Group Members’ Full Names: Mr. Williamson

Song Description...

(Include at least two well-constructed paragraphs explaining your song. You should
include both musical elements (instruments, form, etc.) and non-musical elements (how
you came up with the title, how your group worked together, etc.) for your project.)

This song, Hopsicle, is a Binary Composition. The song is called
Hopsicle, because the A Section of the song is a Hip-Hop style. The piece

starts with a hip-hop digital drum beat and a club dance bass loop. After
a short four-measure introduction, the Southern Piano enters with the
Melody. In the A Section, the Southern Piano uses a series of different
loops to keep the melody interesting, as the bass and drums provide the
steady harmony. The Piano track volume was edited to sound more
expressive, with softer and louder sections as the piano plays. The A
Section starts to transition with a few Latin rhythms in the piano at
measure 25.

The B Section of the song starts at the twenty-ninth measure. To
contrast the A Section, the B Section has a different style. It takes the
listener into a cool Caribbean feel, with the Latin Piano loops at measure
twenty-nine. Two measures later, at measure thirty-one. two Steel Drum
patterns enter as a duet. To reinforce the Caribbean feel, two acoustic
percussion loops join in softly, and then get louder. After a few
measures of getting louder, they reach their crest at measure 38, and
start to fade out. The song ends with both steel drums and the piano
playing two loud, unison chords.

3%
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Song Description Sheet Rubric Name(s):
[}
" o Exemplary (4 points) Proficient (3 points) Developing (2 points) Beginning (1 point)
Writing demonstrates an established *  Writing demonstrates a maturing ¢ Writing demonstrates a developing *  Writing demonstrates a strong lack of
" vocabulary and descriptive nature vocabulary and descriptive nature vocabulary and descriptive nature vocabulary and descriptive nature
€ regarding the musical elements in the regarding the musical elements in the regarding the musical elements in the regarding the musical elements in the song.
o
g song. song. song. * Two or less than two musical elements are
w Five or more musical elements are vividly | *  Four or more musical elements are ¢ Three or more musical elements are described with multiple errors.
g_g described. clearly described. described with some error.
Ei
b3
Writing demonstrates an established *  Writing demonstrates a maturing *  Writing demonstrates a developing * Writing demonstrates a strong lack of
‘2 vocabulary and descriptive nature vocabulary and descriptive nature vocabulary and descriptive nature vocabulary and descriptive nature
°E-' regarding the non-musical elements in regarding the non-musical elements in regarding the non-musical elements in the regarding the musical elements in the song.
= the song. the song. song. A * Two or less than two non-musical
§ Five or more non-musical elementsare |+ Four or more non-musical elements ¢ Three or more non-musical elements are elements are described with multiple
'g vividly described. are clearly described. described with some error. errors.
2 | ’
=
o
4
2 Writing demonstrates an established *  Writing demonstrates a maturing * Writing demonstrates an developing ¢ Writing demonstrates an strong lack of
s vocabulary and strong vision for song vocabulary and vision for song vocabulary and some vision for song vocabulary and absence of vision for song
£ improvements. improvements. improvements. improvements.
Q
§ Five or more items for improvementare |* Four or more items for improvement |+ Three or more items for improvementare [ * Two or less than two items for
g vividly described. are clearly described. described with some error. improvement are described with multiple
= errors.
-
3
]
4
Descriptive writing fulfills its purpose by | *  Descriptive writing meets its purpose | *  Descriptive writing somewhat its purpose | ¢ Descriptive writing lacks purpose by failing
2 presenting a clear and complete picture. by presenting a mostly clear and by presenting a somewhat clear and to presenting a clear and complete picture.
K \ complete pi . lete picture. . .
- The detalls are presented in a plete picture comp t pictur . ¢ The details are not presented in a
§ recognizable and appropriate order. ¢ Thedetails are presented ina mostly |+  The details are presented in'a somewhat recognizable and appropriate order.
. recognizabl ropriate order. n riate order. . L )
Eo The writing is free of misspellings and gnizable and approp 0 recognizable and ap prop late order * The writing contains many misspellings
£ words are capitalized correctly. * The writing is mostly free of ¢ The writing is somewhat free of and/or many words are capitalized
§ misspellings and most words are misspellings and some words are correctly. -

capitalized correctly.

capitalized correctly.
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Project 1: Tutorials

Tutorial Topics

1-1  Creating Your GarageBand Project

1-2  Starting Your Song with a Beat

1-3  Auditioning More Musicians

1-4  Building Your Song Over Time.

1-5  Introducing Melody

1-6  Creating Drama with Call and Response
1-7  Setting the Tone with an Introduction
1-8  Adding Interest with Key Changes

1-9  Ending Your Song with a Fadeout

1-End Exporting Your Song to iTunes
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1-1 Creating Your GarageBand Project

With GarageBand, you can create your own music, whether or not you play
an instrument. Use your imagination to choose, combine, and arrange
prerecorded pieces of music called loops to make your own composition.

GarageBand includes a loop browser that lets you try out, or "audition,"
loops and a timeline where you can arrange loops into a song.

Steps
Try out the loops included with GarageBand

1. Open GarageBand and click New Music Project.

2. In the window that appears, select a tempo and key for your song, and then click
Create. The The GarageBand window opens and a track is created for you that
uses the Grand Piano Software Instrument.

In the lower-left corner, click the Loop Browser button.

Click a category. Notice that some of the other categories are unavailable.

Click another category and notice the list of loops in the audition window is
shorter and includes loops that match the criteria for both of the categories you

selected.
6. Select a loop to audition it. Notice that each loop includes information about its

key, tempo, and length.

1-2 Starting Your Song with a Beat

Rhythm is the backbone of your song, so it's a good idea to start by
picking a drum part. You'll be able to hear the rhythm clearly, which will
make it easier to choose appropriate accompaniment.

nhw

You can choose from dozens of different drum loops for your song. It’s a
great way to get your musical ideas flowing, and to start building a
rhythmic framework for the rest of your song.

Steps
Add a drum track to your first mix

In GarageBand, click the Loop Browser button to open the Loop Browser.

. Click the All Drums category to show the available drum loops.

. Click a drum loop to audition it.

. When you find a loop you want to use, drag the loop to the timeline under the
Grand Piano track. Notice that a new track is created with this loop.

. Click the Play button in the track controls to play your loop.

-th!-l
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1-3 Auditioning More Musicians
To round out your rhythm section, bring in a bass player. Adding bass
provides a tonal element to the rhythm of your song.

You can let your drum loop play while you audition bass players for your
band. You don't have to worry about the tempo or the key of the loops—
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they automatically play back at the same tempo and in the same key of
your song.

Steps
Audition other loops for your mix

1. In GarageBand, click the Cycle button to turn on cycling. A yellow bar appears
above the track editor showing the portion of the song that will be cycled.

2. Click Play. Your drum pattern will play repeatedly until you stop it.

3. In the loop browser, click Reset. Notice that the categories you selected

previously are deselected.

Click the Bass category.

Audition a bass loop for your song by clicking a bass loop that interests you. The

loop plays in time with your drum loop, even if you select a bass loop with a

different tempo than your song.

6. When you find the loop you want, drag it to the track editor under your drum
track. A new track is created with your bass loop, and your drum and bass loops
play together.

vk

1-4 Building Your Song Over Time

Now that you’ve set up a groove with your rhythm section, you’ll want it to
last longer than a few measures. For example, you might want your song
to be the same length as an iMovie project or iPhoto slideshow you made.

You can stretch your loops to any length you want in the timeline.

Steps
Extend your rhythm section loops

1. Hold down the Shift key and click your drum loop, and then click the bass loop.

2. Position the cursor in the upper-right corner of one of the loops until the looping
icon appears.

3. Drag the loops to play for 16 measures (until you see the number 17 in the
timeline ruler). Notice that the loop duration is marked by a bubble shape for
each loop.

4. Click the Cycle button to turn off cycling.

5. Click the Play button to hear your song.

6. Click Tempo and use the slider to hear your mix at different tempos.

1-5 Introducing Melody

Gnce you've set up your foundation, you can add melodic elements to
really make your song come alive. Melody is what makes a song a song—
it’s the part you hum to yourself.

Audition other instruments while you cycle the rhythm section of your song.

Try the loop categories of single instruments for distinctively melodic
loops.

Lo
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Add melodic elements to your song

1.

@ vhrwnN

O 2N

1-6

Click the Cycle button and then click the Play button to play back your drum and
bass loops repeatedly.

In the loop browser, click Reset.

Click the Guitar category, and then click Single.

Click a guitar loop to audition it.

When you find a guitar loop you like, drag it to the track editor to create a new
track with that loop.

Drag the cycle indicator to play the portion of the song that includes all three
loops. '

Click Reset.

Click the Piano category and audition piano loops with your mix.

Drag the piano loop you want to the track editor under your guitar track to
create a piano track.

Creating Drama with Call and Response

The essence of music is interaction. You can add tension to your song and
create the impression of musicians playing together by playing different
melodic loops one after another. This is known as "call and response."

You can stretch your melodic loops to match the song length, and then
divide them into separate regions. You can cut and paste these regions
to create the effect that the loops are answering each other.

Steps
Offset

1,
2.
3.

8.
9.

1-7

the melodic loops from each other to add tension

Hold down the Shift key and click the guitar loop, and then click the piano loop.
Position the pointer in the upper-right corner of one of the loops and drag the
loops out 16 measures.

With the guitar and piano loops both selected, drag the playhead to the
beginning of measure 5.

From the Edit menu, choose Split. Notice that both the loops are now labeled
separately before and after the position of the playhead.

Drag the playhead to the beginning of measure 9, and then choose Split from the
Edit menu.

Click outside the guitar and piano loops to deselect them.

Click the first segment of the guitar loop and then choose Cut from the Edit
menu.

Click the second segment of the piano loop and then choose Cut from the Edit
menu.

Play your song and notice how the piano and guitar loops respond to each other.

Setting the Tone with an Introduction

A good song needs an introduction to set the mood before it gets going.
An introduction also creates anticipation, and gives the listener a chance to
tune in before the main part of the song starts.
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You can create a simple introduction for your song by letting the drums
play alone for a couple measures before the rest of the song starts.

Steps
Create an introduction for your song

1. Drag the zoom slider (located below the track headers) to the left until you can
see the beginning and end of every loop in your song.

2. Hold down the Shift key and click the bass, guitar, and piano loops.

3. Drag the loops two measures to the right.

4. Click the top-right corner of the drum loop and stretch it to line up with the end
of the other tracks.

5. Click Play to hear your introduction.

1-8 Adding Interest with Key Changes
You can give a sense of movement and progression to your song by
changing the key. When you first set up your GarageBand project you
choose a key signature, which determines the root note of your song.

You can create a key change in your song by changing the Master Pitch
and all the tracks in your song will be changed. This is called transposing.

Steps
Change the key of a section of your song

1. Listen to your song and determine where you want a key change, and move the
playhead to the beginning of that measure.

2. Go to the Track menu and choose Show Master Track. Notice the new track that
appears at the bottom of the track editor.

3. Select Master Pitch from the POp-up menu in the Master Track header. Notice

the line that appears at the "0" point in the track.

Click to add a marker to the Master Pitch line at the playhead.

Drag the marker up to +7.

Click to add a second marker where you would like the key to change back.

Drag the second marker down to 0.

Click Play to hear your song.

PNV A~
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1-9 Ending Your Song with a Fadeout

When it’s time for your song to end, you don’t want to Jjust stop it abruptly.
With GarageBand, you can create a fadeout to let your song end gradually.

A fadeout indicates your song is ending and makes it possible to transition
smoothly to another song.

Steps
Gradually fade out your song

1. From the Track menu, choose Show Master Track. A new track appears.

2. Select the Master Volume option. Notice the volume curve in the timeline is
enabled.

3. Click the volume curve at the point in your song that you want to start the
fadeout. Notice that a circle appears in the volume curve.

4. Click the volume curve at the end of the song and drag it down.

5. Click Play to hear your song with the fadeout.

1-End Exporting Your Song to iTunes

When your song is finished, you can export it to iTunes so you can listento
it on your iPod or use it with your iMovie projects, your iPhoto slideshows,
or with your iDVD project.

GarageBand automatically puts your song in your iTunes music library,
where you’re listed as the artist.

Steps
Export your song to iTunes

1. From the Share menu, choose Send Song to iTunes.

2. Notice that iTunes opens and starts playing your song.

3. You can now listen to your song in iTunes, transfer it to your iPod, or use it with
your slideshows like any other song in your iTunes library.
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Submitting Your GarageBand Project to  education

1. First, you must convert your GarageBand song to an MP3 file...
a. With your GarageBand file open, use Share > Export Song to Disk...

M Garagaland. FlisJdit_ Track Control IR
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b. On the pop-up screen, s_e_lect MP3 Encoder, then click the Export button.

Expart your song 1o disk,
121 Comprosy
Curnpress Using: | MIS Encoter B~ |

Audin Sawinge: [ High Quaiity k8
[

I+ Iedeal for musle of ol typey, Download times

are modorate, Detalls: MPY, 120kbps, fieren, |

aptiimldied far music and complin auilia, |
|

| Estimated Siee: 1,0MB,

l , |

(el ) (o)

¢. On the next screen you will choose a file name. Name your file using the
format below, to include details for your section, names and project within the filename.

7 )

Naming Your Project for Google...

T1P4WIGh01.mp3

i

Your Your Name(s): Your Project #:
Section: LAST INITIAL Given by
Trimester 1 first initial Teacher for each
Period 4 (for each partner) project.

Corresponds to Trimester 1, Period 4, Travis Williamson
and Heather Griffin, Project 1

H2



d. On filename is set-up correctl

, click on save to make your MP3 file.
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e. Your MP3 file is now in the folder with t<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>